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COUNTING

=

Point ITCN
Multipoint NMA
PointPicker Find Maxima
Cell Counter Analyze Particles

3D Roi Manager

3D Object Counter




[ {Fiji Is Just) Image =10l %]
File Edit Image Process Analyze Pluging VWindow Help

Olojc|o| << Bl A|a|o] | mskjr 4|/ ]8] 7>
(Fiji Is Just) Imaged 2.0.0-rc-24/1.490; Java 1.6.0_24 [B4-bit]; 41MB of 61130

4

To count several points

[ Point Tool x|
a3
& | 4 o
e Type: ICircIe vI
Colat: Ihﬂa enta vI
or J
............. Size: IMEdi'—lm "I
(. \
< | 4 - Some of these options |
— i — s — "~ I~ Auto-measure
f— .
N~ [T Auto-next slice
~. (o — 4
T T Add to overlay
By double clicking —#—_ you can access some additional options: U Add to ROl Manager
Type: [Circle <] size: [Exra Large v Color: [Magenta ] ™ i ahel points:
o [Hybrid a Green -
-Hcrosshair . 0K | Cancell
® (Dot iy
© [SIHE

@]ca Large el oy
Qrange
Black
Records the pixel location and intensity. White ¥

Automatically advance to the next stack slice.
Points will be automatically added to the

Each point selection will be displayed with an accompanying numeric label.
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[ {Fiji Is Just) Image =10l %]
File Edit Image Process Analyze Pluging “Window Help

0oz |o| <] 4 Al o @A ow|sw|ur| g | s || 2]

I— Multi-Point

*Multi-point* or point (right click tc  Faint Toal o configure)

v hUlti-point Toaol

With a right-mouse click over the Point Tool | —|{:— |t is possible to access the Multi-point Tool

+++ . .
to mar| At al points

u can access some additional options:

o m Size: |Extra Large "I Colorl [Magenta *'I

= [Hybrid Tirmy Green -

—Hcrasshair Small

® Dot Medium

o e ) ! |Large _
a Large "'e o

r
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
i Point Tool x| H :
: Qrange
1
Type: ICircIe vI ! E}Eﬁg =
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
]
1
|
1
1
1
1
1
1
1
1

ODod

Calar: IYeIIuw vI
Size: IE}{tra Large vI

¥ Label points

Label Points: Each point selection will be displayed with an accompanying numeric label.

Counter: counter: |Default = Select counter to group numbers in categories

Counter; \ - Counter; -

:.EIE E".:

u
<«mEs amms

Caunter: IDefauIt vI

1]

s Alt-click, or control-click, on a point to delete it.

e Press 'y' (Edit>Selection>Properties) to display
the counts in a results table.

e Use File>Save As>Tiff or File>Save As>Selection
to save the points and counts.

Lok | Cancell Helpl

http://rsbweb.nih.gov/ij/docs/guide/146-19.html#tsec:Multi-point-Tool
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[ (Fiji Is Just) Image] =10l

File Edit Image Process Analyze Pluging “Window Help

(o] @] (Bl | |l || | | ] ]

PointPicker
(Fiji 15 Just) Imaged 2.0 0-rc-23/1 49m; Java 1.6.0 24 [Bd-bit];

- . [ Color Settings x| . x|
Add point : _ ; : |
e Rainhow Clear All :

Maonochrame Clear Slice

F!ﬁ |Move point b el
Cancel |
Cancel Cancel |

[/ Back to Imaged

Dione |

Cancel |

!ﬁ_ Remove point

File Edit Font Fesults

h i

paint | x | y |slice |color | i | A
0 77 286 1 0 1
1 178 173 1 1 2
2 326 9% 1 2 3
3 445 109 3 a
4 [»]

Go to Analyze/Tools/PointPicker

This tool allows you to pick some points in an image or stack and to save the list

of pixel coordinates as a text file.

= - It is also possible to read back the text file to restore marks over another image.



http://bigwww.epfl.ch/thevenaz/pointpicker/

Cell Counter

1°- Go to Plugins/Analyze/Cell Counter

2° - Select “Keep Original” and “Show Numbers”.

3° - Press “Initialize” (this will create a duplicate image/stack).

40 - Select 1,2,3,...).

You can Rename the types

1O Type 1 ) Positive |
. 1
1D Tme2 - > - Megath.-'ei
' Type 3 ' Nucleus |

6° - Repeat steps 3 and 4 as many times as needed.

7° - Export Image - Makes a copy of the image with the markers written on it .

8° - Results - Shows a table with results.

. Counter Wind -0l x|

188x188 piETS; RGE; 138K

File Edit Font

o m]

Slice |Type1 |Typ82 |Typ83 |Type-£1 |Typ85 |Typ86 |Type? |TypeE | ]

Total 4 4 0 a

G a0, S|

0 0 a 0

~]4|

Delete the last placed marker

Measure - Measures pixels for each marker and displays a table with Type - Slice -

X coordinate - Y coordinate - Pixel Value

=10l x|
Counters Actions
CTypet |71 i Keep Original}
™ Type2 |0 Initialize
) Type3 |0 el
) Typed |0 Remove
© Tyne 5 .D Rename
) Typed |0
O Delete
Twpe ¥
Delete Mode

) Type8 |0

Options

B o Counter Optians ST Besel
Colord
oort [ S| {v| Show Numbers :
coorz | | o PR R P R e
cons | - itk
Color |i| Save Markers
Load Markers
coor7 | | Export Image
Measure...
| Aceptar Cancelar
=Tk

File Edit Font Results

Type [Slice [x [

|Value

1 1

1
1
1
2
2
2
2

Ll

a1 29
FE
147 a4
142 108
32 123
g0 128
14 152
36 169

75.33333587646404
70.6E666412353216
86.0
g2.0
86.0
50 .6EEER 793823242
B3.66666412353516
B8.33333587646484

v21.0
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Sl

@) > Only 8 bits images, NO STACKS

==

ITCN (Image-based Tool for Counting Nuclei)

[ij ITCN: Image-based Tool for Counti ng Nucl =|0O] x|
1°- Go to Plugins/ITCN Image Mame: 05-endosomas.tif (green) tif
2°- Write a line to measure the diameter of the cell and Lty 18 pirels | Measure Line Lengih |
Minimuam Distancel'f— pikels | Measure Line Length
Thrashald]1.0 il 3

press Measure Line Length in the Width menu.

(Recommended: Minimum Distance = Width/2)

3°- Write a line to measure the distance between cell's [ |Detect Dark Peaks

Mask Image |Use selected RO ;l Qpen... I

centers and press in the

menu.
Count Exit

Mark checkbox if you're looking for dark peaks [

4°- Modify the threshold to select cells by intensity and press Count.
5°- Repeat step 4 as many times as needed.

For testing you can use a region of interest and select *

S| )

File Edit Font Results

Image: 05-endosomas tif (green) tf ‘
Mumber of Cells: 30 in 164400,00 sguare pixels
Density: 0,00 cells per sguare pixel

Check how to install this plugin
In page 19

I v 1.6


http://rsbweb.nih.gov/ij/plugins/itcn.html
http://www.bioimage.ucsb.edu/

NMA (Nuclear Morphometric Analysis)

[1J1 NII Plugin e

NI Plugin
1000x%1000 pixels; RGB; 3.8MB

1°- Go to Plugins/NII_Plugin/NII

2°- Choose the options to select.

VSHDW Bounding Boxes
[ Show Ellipse

[T Show Ellipse's Radius
W/Use Watershed

Without Wathershed

Watershed will try to separate some of the
nuclei that are touching each other.

3° - Select directory for results

Save Directory:

Firesultadoss

Choose Direckory

=10l x|

[~ Shaw Bounding Boxes
[~ Shaw Ellipse

[~ Shaw Ellipse's Radius
¥ Usewatershed

Save Directary:

Firesultadass

Choose Directory

Qutput Separator:
& Comma () ™ Semicalan ()

Minimum Muclei Area

| i

L[ B

Maximum Muclei Area

HE] i

1981

Muclei Intensity Segrmentation Threshold

47

MNuclei Inserion Intensity

ll &

Fun MII Plugin

Run Batch

Clear Ignored Muclei List

Clear Inserted Muclsi Lisk



http://www.ufrgs.br/labsinal/NMA/
http://www.ufrgs.br/labsinal/NMA/Supplementary Methods.pdf

4° - Modify the next parameters to obtained a good result.

NMA (Nuclear Morphometric Analysis)

Minirmum Muclei Area

ﬂJ ﬂ The minimum area (in pixels) of a nucleus to be considered.
0

Maximum Nuclei Area The maximum area (in pixels) of a nucleus to be considered.
| i

1951

To select nuclei by their intensity
Muclei Intensity Segmentation Threshold

j J j This is the percentage of the Segmentation Threshold used when
47
Muclei Insertion Intensi . ,
Lo IO NS adding or removing an element manually.
I [ |
1%

| 5° - Select Run NII Plugin to process one image or Run Batch to process every image
Fun MII Plugin

Run Batch located in some folder

Clear Ignored Muclei List [

Clear Inserted Muclei List I

£™5
a nucleus press | Ishife nucleus press CTRL
g .'{I:h.

St

2 @) 2 Values in pixels


http://www.ufrgs.br/labsinal/NMA/
http://www.ufrgs.br/labsinal/NMA/Supplementary Methods.pdf

Find Maxima

1° - Go to Process/Find maxima
20 - Activate

3° - For testing you can modify

to check how it works

(a threshold is set at the

maximum value minus noise tolerance and the contiguous area around the

maximum which is above the threshold is analyzed)

4° - Select the Output type (see next page)

Counts: 191

Counts: 73

Counts: 44

x|
Moise tolerance: |50

..............................................................

[ Exclude edge rmaxima
[ Light backoround

v {Preview point selection:

* 146 Maxima =

‘EEEEEEEEEEERD

0] | Cancel| Help|

Counts: 30
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Find Maxima

Six outputs are possible: Single Points, Maxima Within Tolerance, Segmented Particles, Point

Selection, List and Count.

_
i5i]

File Edit Font Results

x x| =
217 309
296 304
150 302
109 265
84 258
255 255

311 202
204 286
310 231
o 110 296

—= 0 ] -~ o = Ry =

List
Outputtype:  |Point Selection
e

Single Points firesas — —— — = = R
Maxima Within Tolerance FiIE|Edit Font Results | | |
Segmented Particles Lahel Court =
éF'l:lirl‘t Selection 1 03-endosomas tif (green) tif 30 |
List |
Count | 0l

Count

Point Selection Segmented Particles
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Analyze Particles Analyze Particles counts and measures objects in binary or thresholded images

1° - Open the image, apply some filters to smooth surfaces (Median or Mean, usually) and check the best threshold

(Image/Adjust/Threshold) to select the particles of interest.

2° - Go to Analyze/ Analyze Particles and modify the next parameters to obtain a best result

[l Analyze Particles x|

Size (um™2):

™ Pixel units

Circularity;  |0.00-1.00

v Display resulis ¥ Exclude on edges
V¥ Clear results ™ Include holes

™ Summarize ™ Record starts

¥ Addto Manager [ In situ Show

(] 4 | Cancell Helpl

Size Particles with size (area) out of the specified range are ignored. Values may

range between 0 and ‘Infinity’.

Size (pixel™2;

Circularity Particles with size circularity values out of the specified range are also
ignored. Circularity (41 x [Area][Perimeter]2. Ranges from 0 (infinitely elongated polygon)

to 1 (perfect circle).

Circularity: |0.80-1.00
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Analyze Particles Show. This drop-down menu specifies which image (or overlay) should be displayed after the analysis.

Size, color and background of text labels can be adjusted in Image/Overlay/Labels

————
:_Shclw: INnthing vi

e o o e e o o e e o o e e e o e e e o o e e o o e e

[ 1 1 1 I [
| 1 | | | |
I © ) el [ o 6 ol I & . ol
| ‘ : I : I :

| L) @ | N g Q | o o o
sShow: |Overlay Masks = 71 % g%;o s @ I o g@ o ° 1 o ga & O
Mothing - I e o : I o o : I o 0o :

Qutlines <k [ y v O9 I . o Oe [ . -p O-

Bare Outines © ' o - 9 : I N < ¢ 0 I o o O I
Ellipses ! SES P b & @O b i OcC !
: ! I R : I = o o I
Count Masks \ : I : : : :
| 1 | | | |
1 I I I | |

Dverlay Cutlines  ©
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ROI 3D manager can segment 3D objects in a stack and measure various parameters relative to
3D Roi Manager

each object (volume, surface, intensity parameters...) or to the objects relations (distances).

1° - Open the image, apply some filters to smooth surfaces (Median or Mean, usually) and check the best threshold

- s of {1
(Image/Adjust/Threshold) to select the particles of interest. . - =1l
_ Ei'l-“ﬂ“ | _~ 3D Segmentation || Add Image
2° - Go to Plugins/3D/3D Manager. oh —
— -_— i — -
3° - Apply 3D Segmentation and select proper threshold limits l€T T Rename Delete Erase
| | Merge Splitin two
Low Threshold | 40] Pth-vaIB :
High Threshold | 255 r]hjg_uam Measure 3D Quantif 3D
hi10-val10 l Distances Angles
oK | Cancell bhj”'“a”" |
hi12-val2 | Colocalization List Yoxels
jobj13-val13 |
4 - Ani indow with *-3Dseg” will b d .
- An image window with “-3Dseg” will be opened. — — Db :
g g P —_——_—— ” obj15.val1s | 3D Viewer Fill Stack
= hj16-val 16 |
—— = hj17-val17 | Select Al Deselect
lobj18-val18 |
Select and press Add Image jobj19-val 19 Live Roi Label
...... , pizovaizo | gz
to add ROIs to the list. e Igh121-vaI21 | i H % 6
f 2 ,::::__ f /? Casssssssnun
s r - 1 -
it -
. . p st inias. : — =
Set Measurements: Use this dialog box to : == E -
e ] —
s T -

specify which measurements are recorded P oo §

jdocu.tu 1


http://imagejdocu.tudor.lu/doku.php?id=plugin:stacks:3d_roi_manager:start

3D Roi Manager

lobj64-val36

: the measurement are listed for the object(s) selected or for all

 the particles if none is selected

Quantif 3D will display a "3D quantif* window with the grey

level of the objects

 Distance will display a “3D distance” window with the

: distance between objects previously selected.

Colocalization will compute the percentage of the volume of

: co-localised voxels to the object volume

Check how to install these plugins in the last page

Jr"’»:m.l

: Measure 3D will display a "3D Measure* window where all

JTaTE
ohj33-vali3 3D Segmentation Add Image
ohj34-val34

i |obj35-val35

éEhjﬂﬁ-ualﬂﬁ : Rename Delete Erase

i |obj37-val37

: |obj38-valig Merge Spiit in two
/ T Measure 3D Quantif 3D

: |obj42-vald2 .

obj43-val43 A Distances Angles

. Colocalization List Voxels

3D Viewer Fill Stack
hj18-valis
/ ohj49-val49 Select All Deselect
ohj50-val50 . -
Dl:]jﬁ'l-"l.i‘-'ﬂlﬁ'l Live Roi Label
ohj52-val52 —
| = =1 AP

Fill Stack will draw the selected objects in the current stack
Check the Live Roi button if the contours of the selected
objects aren’t displayed in the current 3D image windows

The Label button will add text overlay at the selected object

position in the corresponding slice


http://www.gdja2ip.upmc.fr/index.php?option=com_content&view=article&id=38&Itemid=38

|_ This plugin counts the number of 3D objects in a stack and quantifies several parameters for each
3D Object Counter
found object
['I' 3D-0C Set Measurements ] x|
Parameters to calculate:
v Surface \
First of all, select Analyze/3D OC Options to set the parameters to ¥ Nb of Obj. vaxels ¥ Mb of Surf voxels
. v Integrated Density v Mean Gray value
calculate and other optlons. ¥ Std Dev Gray Value ¥ Median Gray Yalue
IV Minimum Gray Walue v Maxirmum Gray Yalue
¥ Centroid ¥ Mean distance to surface
¥ Std Dev distance to surface ™ Median distance to surface
[1]" Statistics For Nucleos ) 4 /@Eﬂtre Eiass Gl gl J
File Edit Font
i‘vfnlume (m™3) 1Surfa|:e (m*2) IND of obj. woxels 1th of sUrf. woxels [IntDen Ir'ﬂeal RIS e e
1 798 185 Fd0 438 3799 997 370988 99 4 ™ Close original images while processing (saves memang
2 2740130 1555 448 11085 2767 e
a 1616.887 ae7 72 G541 1607 FO2592 105,
4 1348.683 856.153 5456 1401 614267 112 [
5 1467.335 897.237 5936 1531 g09673 102, DetssEs [0
§  1770.838 1116811 7164 1957 773442 107, Fomtem [15
7 1399852 f75.372 5663 1451 r54806 99 7RSSR
«| | I™ White numbers

ResultzTable parameters:

[¥ Store results within a table named after the image imacro friendly)

Rediractio; |nnne =

oK | Cancell



http://fiji.sc/3D_Objects_Counter
http://imagejdocu.tudor.lu/lib/exe/fetch.php?media=plugin:analysis:3d_object_counter:3d-oc.pdf

| 3D Object Counter Once the options have been set, launch Analyze/3D Objects Counter

[']' 3D Object Counter ¥2.0 x|

Threshold 4 | 3 14|;||

Slice 4 [ S

cleas 10/ x]
M3 (Ch1); 152.64x152.64 um (307x307); B-bit, 1.2MB

Size filter:

min. [t
S

Max, (12256237

[ Exclude ohjects on edges

Maps to show:
v Objects

IV Surfaces
v Centroids

IV Centres of massgs

Fesults tahles to show:

Iv Statistics

¥ Summary
ik | Canceli
R - ... |
12 T File Edit Font EE File Edit Font
hin. |0} Min. [5000 Be careful with this option. It
122623, Mucleos: 63 ohjects detected - Mucleos: 28 objects detected .
ac | J Max. [122523: : doesn’t work porperly sometimes

4| 1]



http://fiji.sc/3D_Objects_Counter

3D Object Counter Select how do you want to show the information

=10l =| [1]i Surface map of Nu;

307); B-hit, 1.2MB 8013, 152.64x152.64 um 307); 8-hit; 1.2MB
]

I

[i' Centres of mass map =10 L(j
8/13; 152.64x152.64 ym (307x307); B-hit, 1.2MB 8/13; 152.64x152.64 ym (307x307); 8-hit; 1.2MB

[ Statistics for Nucleos

=g/ -lofx
File Edit Font File Edit Font

[wolume (um"3) |Surface (um"2) [Nb of obj. voxels |Nb of surf. vuxe|sj] -
1 798.183 640.438 3229 27 || Nucleos: B3 ohjects detected (Size filter setto 0-122:
2 2740.130 1555448 11085 2767 - . [ >
4 1 »

[/ 30 Dbject Counter ¥2.0

Threshald _j_f _]
Slice 4 il
Size filter:
Min. |1
Max, (12256237

[ Exclude objects on edges

: Maps to show:
: [V Objects
3'"' Surfaces

5'_‘ v Centroids

: ¥ Centres of masses

Results tahles to show:

Iw Statistics
¥ Summary

Ok ‘ Cancel]



http://fiji.sc/3D_Objects_Counter

How to install ITCN plugin

1°- Go to

Downloader
show all downloads
Filename

Category Release

Automatic Nuclei Counter plug-in for Imaged ' ;
1.6 . (04/04/08 13:26:56)

e

:ICTN_l_ﬁ_.jar :

Example images (04704708 16:27:01)

2°- Download ITCN.jar and it into the plugins folder of Fiji

éov & + Equipo = Win7 (i) -

Mombre Mombre « ;I
[uts
. AIM
| macros
| Archivos de programa |:> .
lugins
I —————
| refra
. Fiji.app
| sCripks

l C:\Fiji.app" plugins' CONTAJE

@Oﬂ - = Fill.app ~ plugins - CONTAJE

. C:Fiji.apph plugins

-

GOﬂ - v WInT (Cr) - Fijl.app + plugins -

) Adapk | Mosaic_ToolSuite
| Analyze J MIT_Plugin
| CMTE_Regiskrakion J Crienkation]
J colocalizacion | Ratio
B contaE:  Seripts
|:> | Deconyolukion | Skeleton Analysis
| Diarneter] | Lltilities
| Examples | |Align_RGE_planes class

You can create some additional folder inside the plugins one to locate that plugin easily in the plugins menu

3°- Restart Fiji to become the plugin available in the plugins menu.

1 I
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How to install 3D Roi Manager

Image] Wehsite
Image) News...
o_ - Documentation
1°- Go to Help/ Update Fiji Hl
Mailing List
Dev. Resources. .

Zimix

Fluging

Macras...

20- Open Man age update SlteS Macro Functions

Examples 3

Update Image.! H
H Mame |

Statusfaction | Update Site

Refresh Menus

About Plugins Iz
About Imaged...

Report & Bug
Help on Menu ltem

Licenses

Switch ta Modern Mode
Fiji Wik

Update Fiji

Update

.
™,
LN
i
‘e
0
.
"
e
e
.
o
‘e

! Manage update sites I I Apply changes I‘ Advanced mode | ‘ Cancel ‘

Upload Sample Image

3°- Select 3D ImageJ Suite

A E

(4. Mame URL Host | 4°- Select Close
| Imaged httpfiupdate imagej.netl |

Fiji hitpeifupdate fiji sl 5o- § .

- Select Apply changes
|3D lmaged Suite httpfisites.image). netThoudier I PPy 9
I 118~ nnfaranca - ficitos irmanal nattI01 S T onfaranearl I‘.".
1 0.

| Add my site Add update site Remowe Close | 6° - Restart FIJI'
L ]

http://fiji.sc/How to follow a 3rd party update site // http://fiji.sc/Update Sites // http://ffiji.sc/Installing _3rd party plugins
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